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Final Review: The Lowdown on Office 2007

Richard Ericson

October 11, 2006 () Simplify, simplify, simplify. The challenge for Microsoft in revamping Office was to better organize all the options
available without negatively impacting productivity. For new users, that's a particularly important goal, since the menus and toolbars in
current versions may appear to be a mishmash.

The overriding design goal for the new user interface, Microsoft says, is to make it easier for users "to find and use the full range of features
these applications provide" while preserving "an uncluttered workspace that reduces distraction for users so they can spend more time and
energy focused on their work." The redesign makes most Office 2007 applications look completely fresh, clean, new -- and more colorful.
From Ribbons that offer clearly labeled buttons to thumbnail previews of most graphic features, the applications bear only a slight
resemblance to their former selves.

You'll probably get used to the new interface within a few hours; whether you like it, however, is a different story. New users will benefit
most, since they won't have to change existing habits. For advanced and power users, the adjustment may be a bit more disconcerting, at
least initially.

We've put the Technical Refresh of Office 2007 Beta 2 through its paces, exploring new features, both Office-wide and in specific apps, and
taking a particularly close look at the new SharePoint Server 2007. We expect only a few changes (to root out the last bugs and
performance bottlenecks) before the final version ships later this year (to businesses) and early next year (to consumers).

A new look, starring the Ribbon

In Word, Excel, PowerPoint, Access and most areas of Outlook, the menus and toolbars of previous versions are history. In their place is
the Ribbon, a tabbed, horizontal bar divided into groups of icons and buttons organized by task.

The Home Ribbon in Word_contains groups related to the Clipboard (cut, copy, paste and, for some odd reason, the Format Painter), Fonts
(font style and size, plus formatting characteristics such as bold, italic and subscript), Paragraph (for bullets, indenting text, sorting
paragraphs, alignment, line spacing and shading), Styles (displayed as a thumbnail gallery), plus Editing (find, replace and text/object
selection).

The Home Ribbon covers about 90% of everything you'll need for simple text editing -- the remaining features are dispersed throughout the
interface: spell check is on the Review tab, while headers and footers have been moved to the Insert tab (from the View menu in earlier
versions). The core formatting features appear on yet another pop-up menu when you select text.

If you want to add a little more spice to a document, the Insert Ribbon has groups for creating and inserting tables, images, links and
special text (one group for boxes, WordArt and drop caps, another for equations and symbols). Other Ribbons are provided for controlling
page layouts, performing reviews, and defining the current view.
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Word's Home Ribbon has most of the tools you need

Excel's Ribbons are similar: Home (for worksheet editing, formatting and sorting tasks), Insert (to add charts and graphs, hyperlinks and
headers/footers), Page Layout (for controlling cell size, grid lines and backgrounds), Formulas (including a new Name Manager for handling
named ranges), Data (for import/export, removing duplicates and grouping data), Review (for comments and data protection), and View
(freezing panes, adding page breaks and more). At the bottom of some groups is a tiny arrow button that, when clicked, opens a familiar
dialog box. Most dialog boxes are unchanged from previous versions of Office -- still dull gray, but at least the options are where you expect
them to be.

These "standard" Ribbons are supplemented with contextual ribbons that appear when you're working with a particular object -- a table in
Word, an Excel chart, a diagram in PowerPoint -- then disappear when you click away from that object.

Microsoft says the Ribbon doesn't occupy more space than the standard toolbars of previous versions, though it feels larger. Fortunately,
Ribbons can be hidden (Ctrl + F1 is the secret toggle), giving you more document workspace.

The Ribbons can't be customized from within the Office application. Microsoft's Office Ul guru, Jensen Harris, says that they're XML-based,
and that the company is working with third-party developers who are building ribbon-editing utilities for customizing the interface. None has
been announced yet.

Instead, Jensen suggests, users who want a customized look can add icons to the Quick Access Toolbar (QAT), a button strip that can be
docked above or below the Ribbon. (It's above the Ribbon.) Right-clicking on the QAT, or from several other dialog boxes, lets you add
buttons, such as the spell check, that are missing from the Home Ribbon. Keyboard shortcut enthusiasts can press the Alt key to see small
boxes that represent the available shortcuts for the current Ribbon plus all buttons on the QAT.
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Press Alt to see the shortcut keys for editing commands

We found that the new interface made some tasks in Office 2007 harder to complete than in previous versions. With no menu, and
depending on what you're doing, it can take a greater number of mouse clicks or keyboard tapping to perform simple tasks, such as
switching between two open Excel workbooks -- another reason you may soon find yourself with a crowded QAT.

Galleries provide visual shortcuts to many formatting tasks in Office 2007 applications, from applying styles in Word and choosing chart
styles in Excel to applying a fresh design to a SmartArt illustration (more on SmartArt below) in PowerPoint. Select a range of text in Word,
for example, and you can quickly apply a style by picking it from the Style Gallery. Hover over the gallery and your selection will change so
you can preview its effect; move away without clicking and your selection is unchanged.

You aren't restricted to gallery defaults; you can easily add an element to the gallery, and Office will create a preview image. For example,
we created red text in a 16-point font for a heading, and we were able to quickly add it to the Style Gallery; Word displayed text in that style
as a button in the gallery.

Of all the features in Office 2007, graphics have received the greatest (and most interesting) improvement. Apps within the suite now
feature a classier, more professional look, with new 3D effects, shadows and glows, as well as more surface textures, good-looking color
schemes and new ways to add emphasis.

There are more ways to see how your work will look. A new Live Preview feature helps you preview choices -- for instance, in Word you
can hover over a font name and Word will change your selection to that font. Click the font, and the change is made; move your mouse
away, and Word returns to the original formatting. In Excel, you can change the look of a graph the same way. In fact, charts are
dramatically better looking in Office 2007, and PowerPoint users now get the full benefit of Excel's new formatting power when
incorporating charts -- say goodbye to the adequate but dull MSGraph charts of old.

What's missing, what's better

Some features have been radically changed since Office 2003 -- or have disappeared completely. The ability to add a favorite folder to the
My Places bar is no longer found in the File Save and File Open dialog boxes. Instead, you navigate to the folder, right-click on a blank spot
in the My Places bar and choose Add from the pop-up menu. Other My Places features remain unchanged: For example, you can't remove
the default shortcuts such as My Documents without editing the registry.

Task Panes, which offered an attractive list of the last files used (an alternative to the file list in the File menu) in Office 2003, is no more
(though it does appear in some functions, such as mail merge). The Work menu of previous versions, which allows you to keep a list of
your favorite files, is also gone; however, the File list (displayed by clicking on the brightly colored Office Button in the upper-left corner
above the Ribbon) lets you "pin" a file to the list so it's always available. That's a nice design improvement to a feature that few users knew
about, let alone used. Whether most users will intuit that clicking on the pushpin icon keeps the file in the list is unclear.
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Fig 4: "Pinned" files always appear in the Files list

On the plus side, new options let you set the Paste command's default behavior; now you can select which format to use when you paste
text within the same document, from a different document, from a different document when there's a style conflict, and from another
program. You can keep the original's format, use the destination's format or just paste plain text.

We found much to praise in Office 2007. SmartArt lets you build some amazing graphics -- diagrams, flowcharts and the like. It's easy to
add text to the illustrations; you can quickly adjust the number of elements in a diagram, and Office adjusts the font and graphic sizes and
positions automatically. The results are professional and visually pleasing. Also new: a gallery of styles for headers and footers, which
takes some of the fuss out of creating those elements. Inserting shapes is also easier, thanks to the Shapes gallery.
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Fig 4: Pick a shape, any shape

While the Help system has been entirely redesigned, much Help information is now handled by pointing you to Office-wide topics, so
there's more text to wade through to get your answer. The File Save command, for example, lists commands for eight applications
(including Visio), not just the application you're currently using. To find equivalent keyboard commands from Office 2003, enter "Office 2003
shortcuts" into the Help system to get a link to a program that lets you use a mockup of the current application's menu system to show you
the equivalent commands (when they're available).

Files and formats

The core application formats have undergone a significant change -- they now store parts of a document as separate files in a single,
compressed, Zip-compatible format. This should make files easier to restore should they become corrupted (since you might be able to
restore the text but not macros); in earlier versions of Office, a corrupt file meant no data was retrievable. In Word, the format is named
.DOCXx. In Excel it's .XLSx and in PowerPoint it's .PPTx.

Complicating matters is the fact that some applications actually have a pair of new formats. For instance, a Word document containing a
macro will be named .DOCM, and in Excel, a macro-using file is saved with an .XLSM extension. One advantage of the new format: Files
are smaller, saving both hard disk space and network bandwidth requirements.

When a file saved in the new file format is opened in Office 2003, Office pops up a warning message and, if needed, asks if you want to
download a conversion program (a step that's needed only once). If you answer yes, you'll be linked to a Microsoft page where you can
download a 26.6MB "Compatibility Pack." Download and installation took us more than 20 minutes, even with a broadband connection.

If you're an early adopter of Office 2007, asking your partners or clients to jump through such hoops is probably asking too much.
Fortunately, you can tell Office 2007 applications to default to saving in the Office 2003 file format, a step we recommend until users of
earlier Office versions are more likely to have updated their systems with the Compatibility Pack.

Speaking of making files smaller, now built in is the ability to remove sensitive and space-using data from a document before you save it, a
feature previously available as an add-in for Word. This new "Prepare" feature lets you strip sensitive information (your name from the
author field, tracked changes and the like) from your files.

If you want to protect your documents from changes, you can convert them to XML Paper Specification (XPS), Microsoft's answer to
Adobe's PDF format. PDF output was part of the original Office 2007 betas; that was yanked (a Microsoft/Adobe spat is alleged), though
the functionality is still available -- you simply need to download and install an add-in from Microsoft's site.

A few words on Word

Word has some small but annoying changes for experienced users -- for example, the Normal.dot template defaults to 10-point spacing
following a paragraph. On the other hand, there's a new default font (Calibri) that we like, though it often appeared too light when viewed in
previous versions of Office. The status bar in Word 2007 sports buttons for the different views (Print, Web, Reading, Outline and Draft), plus
a slider to change the zoom level. You also have more control over the status bar -- check some boxes and you can display the word count
(updated constantly), caps lock status, and more. Thanks to some refinements in the interface, watermarks, citations and cover pages are
easier to work with, and a new dialog box makes more sense when comparing documents.

Comparison settings
¥ Insertions and deletions ¥ Tables
v Moves ¥ Headers and fookers
v Comments ¥ Footnotes and endriotes
¥ Formatting V¥ Texthoxes
¥ Case changes v Fields
v white space

A more useful Compare Documents dialog box
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Little has been done to address the subject of a key customer complaint: mail merge. Word 2007 uses the same wizard (in a Task Pane) as
Word 2003. The spell checker is still flawed; add a custom word (Computerworld, for example) to the dictionary and Word still isn't smart
enough to know that the possessive form (Computerworld's) is correct as well.

Some productivity options are implemented with no apparent thought at all. For example, the Insert Table command offers a variety of
Quick Tables. That sounds promising, but selecting the Calendar2 option inserts a calendar for May (no year specified) rather than the
current month's calendar (you can't even choose the month and year you want). This is certainly quick -- and completely useless.

Quick Parts is the new name for inserting fields (current date, for example) or document properties (such as author name); hover over the
field and a box appears to indicate the field name displayed (see below). You can also copy text or graphics from a document and create
your own Quick Part, which you can preview in the Building Blocks Organizer.

Hovering over a field shows you the name of its property

Excel: The eyes have it

Some of Excel's useful but underused features have been brought to the fore in Office 2007, including saving a workspace (a collection of
open workbooks), freezing panes and tracking changes. You can quickly remove duplicate rows thanks to a new interface.

Likewise, PivotTables, powerful but complex analysis tools, are easier to create and manipulate thanks to a Task Pane that lets you check
boxes rather than use the awkward drag-and-drop technique of previous versions. The interface makes it easier to apply filters and select
multiple conditions at once. New styles make PivotTables more attractive.

In addition to the graphic artistry of SmartArt, Excel's charts are much better looking -- shadows and glow effects add great dimension --
and are easier to control.

Widget Sales

Shadow effects on a pie chart

Charts aren't the only way to understand data quickly, however. Excel offers new ways to compare data or spot anomalies. For example,
you can set the background of a cell to show a bar with a length proportional to the data value contained within it.

The feature uses gradient fills with moderate success; we found it useful for comparing values but not for evaluating values (a bar twice as
long as another is only a rough approximation of the values it represents). A further caveat: In some worksheets we created, a bar
representing a value of 200 didn't always look twice as long as a bar representing the value 100.

If you like, you can instead use full-color backgrounds to indicate values, or assign icons (up or down arrows, for example) based on the
values within cells.
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2 |Adams 798 632 481
3 Baker 638 912 20
4 |Carson 620 393 964
5 |Davis 747 234 130
6 |Eagleton 742 242 509

Indicate cell values with color

A different approach to visualization is to use a color scale (from green to yellow to red, for example -- you can choose a default color
scheme or specify your own beginning and ending colors). This is easy to apply but initially proved more puzzling to change. (The secret is
to use the Manage Rules option from the Conditional Formatting button in the Home Ribbon, then select "Format all cells based on their
values".) Also new: icon sets (think of inserting a traffic signal's red, yellow or green light into a cell) based on cell values.

Table formatting takes advantage of a gallery of styles, and a new set of cell styles lets you highlight individual cells or ranges with some
attractive, predefined settings (similar to styles in Word).
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Pick a table style and go

Speaking of formatting, as with Word, PowerPoint and Access, if you're connected to the Internet, you can easily choose from a variety of
templates from the Microsoft Office Gallery. Use one and it is added to the File/New dialog box's "Recently Used" section (complete with
thumbnail image).

The Formulas Ribbon contains colorful icons for formula categories (date and time, logical, financial and so on), but there's no new help
once you begin building a formula (the Excel 2003 interface, maintained in Excel 2007, is probably adequate for most users). Unfortunately,
if you press F1 for help, Excel isn't smart enough to show you a help screen for the function being used.

As with Word, the organization of some Excel 2007 features is puzzling. Locking cells is under the Format command of the Home Ribbon,
not in a separate security group. Many formatting buttons actually sit in the Number group on that Ribbon (for changing the number of
decimal points, for example) -- options that were found using the Format/Cells menu command in Excel 2003. To insert a symbol, you'll find
the Symbol button in the Text group of the Insert Ribbon in Excel but in the Symbols group in Word (which has a small gallery of frequently
used symbols).

One thing's for sure: There are fewer constraints in Excel. You can now have 16,385 columns (up from 256 in previous versions) and
1,048,576 rows (up from 65,536). Other limitations have also been eased: A workbook can have 1,024 spreadsheets, there are 64 levels of
sorting (including the ability to sort by color) and AutoFilter drop-downs can show 10,000 conditions (up from three). Functions can now
have 255 arguments, and the maximum length of formulas has been raised to 8,000 characters (up from an already generous 1,000) with
support for up to 64 levels of nesting (up from seven); in addition, the formula bar now expands to handle long formulas. Functions can now
have 255 arguments (up from 30). For other new limits, see MSDN's Excel 2007 blog.

Excel has a neat trick up its sleeve when it comes to tables. Right-click in a table and choose Create Table; Excel will automatically create
column headings and AutoFilters. Those headers stay in view (the column headings replace the standard column letters) as you scroll
down the page -- without any work on your part.
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PowerPoint improvements

Just as galleries help you apply Styles in Word and chart templates do so in Excel, the new PowerPoint 2007 Theme Gallery gives your
presentations a more sophisticated and graphically appealing design, and the one-click feature lets you apply a consistent look and feel
across the entire slide set. It's more than just changing such simple things as fonts and colors -- in addition to changing background colors,
it will change the color scheme for diagrams, tables and charts.

As in Word, you can convert a bulleted list into a rich SmartArt graphic (perfect for flowcharts and workflow illustrations).
Useful new features in Outlook

In terms of new and useful features that help you get your work done, Outlook 2007 leads the pack. Some improvements focus on making
components work together -- previous versions let you flag a message for follow-up, but in Outlook 2007 you can right-click on the flag icon
to add the message to your task list.

Calendars are an important part of Outlook; the 2007 version lets you display multiple calendars side by side or with appointments
superimposed (color coding tells you the source. Below the calendar display is a brand-new task view with your appointments and tasks
listed. To schedule time for the task, just drag it into the calendar.

Also new in this version is a To-Do bar that integrates a calendar, a look at a few of your upcoming appointments and a task list -- all
contained in a single, optional pane.

To-Do Bar B X
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Your To-Do list in a single pane

In terms of messages, Outlook finally adds the ability to view RSS feeds as just another message type, though we'd like to see a smarter
way to add such feeds when you view a Web site that hosts them. As with e-mail messages, you can apply rules to RSS feeds, moving an
RSS feed item to another folder based on a keyword, for example.

Among the other changes is a new Instant Search that lets you locate information in e-mail messages, your contacts, tasks or calendar
items; indexing is handled automatically. Microsoft says searching these Outlook items will be incorporated into Vista's search engine as
well.

Not much new in Access

Access has mostly undergone a facelift. The program continues to provide a strong set of tools for building database applications, but while
its new interface and set of prebuilt database templates is a welcome addition, there's little under the hood that makes it a more powerful
product.

As in previous versions, you can work with many data sources, including Microsoft SQL Server, and now you can integrate an Access
database with SharePoint (you can save it to a Document Management server to provide greater access and control, a feature we did not
test), but that's about it.

Introducing SharePoint

Earlier this year, Microsoft Chairman Bill Gates called SharePoint Server 2007 the "most revolutionary element" of the upcoming Microsoft
Office 2007 suite. It's a separate product, not technically part of the actual Office suite of applications, but it is revolutionary.

Microsoft Office SharePoint Server (MOSS) allows groups to easily create and update sites for collaboration and communication. It offers
well-designed screens that help you customize the content, and you can quickly interact with these sites -- adding new files, updating
reports and so on -- from several spots within Office applications.

1870 W. 64" Lane, Suite E ¢ Denver, CO 80221 « Tel (303) 573-VolIP (8647), Fax: (303) 216-2757
www.buffcomm.com



Let Us Be Your Technology Buffs

Hicme Weloome COMPACSERVERTAdminis!
g4 TOL Office 2007 Tips [Aistes |
Haoma | Document Cenber  Mews »  Reports  Ssarch hm.l

Wiave All Siba Conbant Home > Sihes = TOL Offica 2007 Tips
Site Hierarchy
3 §fl werdTips

1

|

! TNips and tricks for Office 2007
3 Shared Docurments |

I

|

|

|

1

|

|

Shared PPT Slides

Bl sy SFieed F
LallE 0 b

-3 Shared PPT Slidas , _. ; .
In.t._-] ‘Safe Harbor Stabement COMPAGSERVER | Administr ator

An nk
‘—] bl ) MDA Statement COMPACEERVER Adrministrabor
8| Calendar
= Add new docurnent
= riks
2] Tasks
o TOL Report
; Shared Documents ¥ =l Excel Web Access - 2007 Sales Forecast
i Team Disoussion -
Cpen = Update = A Find view: Allsales
i= 2007 Sales COMPAQSERYER \rich
_I Foracast 0.1 Q: 0.3
For Web Marth 673 288 45
lj__:ﬁ Excel COMPAQSERYER bom Sauth ElS 1000 355
| Chart
! Exaihs East 37 734 196

A SharePoint site

Central to SharePoint is the ability to select components -- a calendar, a document library, a list of headlines from an RSS feed -- and
organize their display into a "site". The components, called Web Parts, are organized in one of three areas on a site, with a choice of layout
variations available. There are several predefined Web Parts, including forms, images, task lists, announcements, discussion forums, and
more. You can have more than one Web Part type -- a production team and a testing team calendar, for example -- on your site. Your
SharePoint site can have multiple pages, and you can organize subsites in a hierarchy, much like folders on your hard drive.

If you don't want a site with multiple Web Parts, you can create what SharePoint calls a Document Workspace -- a simple layout that lets
you share documents about anything you choose. We built a Document Workspace to serve as a central repository for next year's
marketing plans -- Word narratives that explain assumptions and high-level plans, Excel forecasts, and the like. Defining the Document
Workspace took a couple of mouse clicks, and in just a few seconds we had a separate SharePoint site devoted to the project. In addition
to creating a shared-document list, the default Document Workspace we chose included team announcements and a task list. As with any
other SharePoint site you create, you can incorporate any additional Web Parts you need.

Sharing with Office applications

The power of SharePoint comes not only from its simplicity in setup but its interaction with Office applications. For example, Excel 2007
offers the ability to render a spreadsheet in HTML and then permits others to view only the parts of a spreadsheet you want them to see via
their Web browser. That's a useful feature, but pair Excel with SharePoint and you can create a worksheet that is shared on a SharePoint
site (using the Excel Web Access Web Part) and which can be viewed or edited (your choice) by visitors..

There are interrelationships galore. Information stored in a SharePoint site can be taken off-line using Outlook folders. You can share
OneNote notebooks via a SharePoint site, and OneNote's optical character recognition search is then shared with SharePoint (the feature
lets you search for text within an image, among other capabilities).

We created our first site in about 10 minutes, added a few Web parts in another five minutes, then rearranged the Web Parts we had added
just as easily. By checking a few options, you can add a team calendar; with a few more mouse clicks, visitors can add it to their list of
available calendars in Outlook 2007 and then view team and personal appointments in Outlook's new multicalendar view. Changes made to
the team calendar from the SharePoint site are automatically updated in Outlook 2007; changes made to the team calendar in Outlook get
synched back with SharePoint.
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Share an Outlook calendar with SharePoint

Once it was set up, we added a new document library for sharing PowerPoint slides. These slide libraries provide a two-way connection
between shared content and your application. You can build a PowerPoint presentation and select which slides to add to the library or
create a presentation and easily incorporate slides from these libraries into your current slide set. If you wish, you can ask SharePoint to
notify you when a shared slide changes (when a logo or company motto changes, for example), and you'll be prompted to update your
slides the next time you open the presentation.

Any member of the team can be permitted to contribute files to these libraries. These shared libraries, which can store any document type,
have an additional benefit: They come with automated check-in/checkout and versioning functionality. SharePoint also enables
permissions-based control so you can manage who can access, view and make changes to documents stored on the server. All Office
applications add a new "Publish" feature that provides links to the available SharePoint sites.

Use slides from a SharePoint library in your PowerPoint presentation
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Users can take advantage of SharePoint's power and simplicity by creating their own "My Site." Not only do they get the same tools as a
SharePoint administrator, but they can build and manage their own sites with the same tools. The "Publish" option from within the Office
suite puts saving a file to your own My Site document library just a couple of mouse clicks away.

Managing workflow

Another SharePoint feature lets you attach a document to a workflow, so it will be routed from worker to worker following the rules you
define. This makes it possible to route a PowerPoint presentation or Excel worksheet through an approval process so each team member
can be part of a formal approval process and must sign off on a document. The Workflow Designer lets you specify each step, the
conditions to look for, and the actions to take (send an e-mail, update a list item, and so on). If your organization needs records
management, new features let you incorporate repository features -- setting up a vault to ensure records are protected from modification or
deletion and building policy-based document retention and destruction schedules is straightforward.

A checked-out document (denoted by a small icon with an arrow) cannot be changed until it is checked in, of course, but just using
SharePoint shared libraries (be it a full site or a simple Document Workspace) may solve one common IT problem: controlling the
proliferation of a single file running amok -- multiplying as duplicate files on every team member's desk and making it impossible to track
who has the latest copy. From within Office applications a new "Publish to Office SharePoint Server 2007" option lets you post a single
copy of a document to a central location so team members are always working with the most up-to-date document. (Additions or changes
to the library can also trigger e-mail notification, either immediately or in daily or weekly summaries.)

If you can't remember where you have a document, the new Search Center lets you find whatever you need anywhere on the SharePoint
site, including looking into the content of shared documents. It can highlight the term you are looking for within the results, collapse
duplicate results and offer "Did you mean...?" alternative spellings. You can set an alert so that any new or changed content matching your
query triggers an e-mail message.

Don't confuse SharePoint with a wiki. While both are designed to share documents and (to some extent) manage workflows, and both can
be viewed in a browser, SharePoint has tight integration with Office applications, can notify you when content changes, can integrate
multiple calendars (and sync them with Outlook) and allows that content to be almost seamlessly incorporated into your own documents.

Other components of Office we did not test include Groove 2007, which lets you review documents collaboratively in real time, InfoPath as
a collection tool for an Access database, the ability to update Microsoft Project files through SharePoint and Excel's Data Connection
Library (to connect spreadsheets to corporate data sources). We also did not test the ability of SharePoint to administer and deploy
business forms using Office InfoPath 2007 templates as browser-based forms that don't need any additional software running on the user's
machine.

Who should take the plunge?

Exact release dates have not been announced for Office 2007. We do know that businesses should be able to purchase Office suites
before year's end, while consumers will have to wait until 2007. But should you update to Office 2007? That depends on the investment
you're willing to make (see Microsoft's Office 2007 pricing information; SharePoint pricing is not yet available) and the benefits you expect
to receive.

For users new to Office, who may stumble on menus and a conglomeration of options spread across many dialog boxes in the 2003
version, the attractive user interface will probably make learning the applications easier. Advanced users who are accustomed to
customizing their interface -- including this writer -- will learn to adjust, albeit perhaps grumbling loudly along the way.

Microsoft's Harris notes that if you're happy with the functionality of Office now and prefer a customizable interface, there's little reason to
upgrade. In our opinion, if you use Office for everyday correspondence and not for creating documents with fancy formats, or to analyze
data or create budgets and update lists in Excel, Office 2007 offers little in the way of new features for the stand-alone user. PowerPoint
profits most from the new graphics capabilities, and Excel charts and graphs will definitely look more polished. Galleries and Live Preview
make it easy to get more visually exciting documents, but that's insufficient justification for the hassle and expense of upgrading.

If you're an IT manager, keep in mind that if you move to Office 2007, your training materials will become obsolete (or unreliable at the very
least). Likewise, the many tips found on Web sites and in books and manuals will be out of date. That could make for a serious setback in
terms of training and productivity, at least in the short term. The trade-off will be if users start to find (and use) features they knew were in
the product but couldn't find, perhaps lowering the cost of support. An unchangeable user interface also benefits your organization's help
desk, since icons will be consistently placed on everyone's desktop (with the exception of the Quick Access Toolbar, of course).

If collaboration and file sharing are on your mind, SharePoint Server and its integration with Office 2007 are impressive. That's the reason
to upgrade. SharePoint installation is strictly for experienced IT pros; this is not a program a small or midsize business should install on its
own. Once installed, however, the ability to create dynamic sites -- and for users to benefit from these tools and create their own My Site
pages -- is extraordinary. Users can be trained to work with shared libraries, calendars, and other content in very little time. That's where
the payback lies.

From: IDG Computerworld, October 11, 2006. Rich&ritson.
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